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THE OPEN UNIVERSITY OF KENYA

DESIGN PLAN

The Design Plan presented below reflects the CUE suggested Plan but goes beyond that to specify how each outcome will be handled. All modules are based on this Design Plan.
Note: The principle of constructive alignment informs this Design Plan.


	Programme title
	BACHELOR OF TECHNOLOGY EDUCATION

	Course title
	CIT 122 Computer Applications

	Learning Module number
	CIT 122-012

	Learning module title
	Input Forms and Reports

	Module Developer
	Dr. Mary Mwadulo

	Module duration in hours
	

	Instructional Hour Equivalent (Divide duration by 2)
	

	Reviewed by
	

	Vision
	The innovative university for inclusive prosperity

	Audience description
	The audience for input forms and reports module can include individuals and organizations that need to create and manage data entry forms and generate reports. This can include:

Business professionals: Business professionals who work with data, such as data analysts, project managers, and marketing professionals, often need to create input forms and generate reports to manage their data effectively.

Government agencies: Government agencies that collect and manage large amounts of data, such as census data, tax information, and healthcare data, need to create input forms and generate reports to analyze and report on this data.

Educational institutions: Educational institutions need to create input forms to collect data from students, such as registration forms, surveys, and evaluations. They also need to generate reports to analyze student performance, enrollment trends, and other academic information.

Non-profit organizations: Non-profit organizations need to create input forms to collect data on donors, fundraising events, and other administrative information. They also need to generate reports to analyze fundraising performance, donor engagement, and other key metrics.

Researchers: Researchers need to create input forms to collect data for their studies, experiments, and surveys. They also need to generate reports to analyze and report on their findings.

Individuals: Individuals who work with data, such as freelancers, entrepreneurs, and researchers, may need to create input forms and generate reports to manage their personal data more effectively.

Students: Students who need to advance their understanding on database as a pre requisite to learning advanced courses in database

Overall, the target audience for input forms and reports module is diverse and can include anyone who needs to manage and report on data efficiently and effectively, from businesses and government agencies to educational institutions, individual users and students.

	Instructions to learners
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	Welcome to Input Forms and Reports module! As your facilitator, I'm here to guide you through this learning experience.
Here are some instructions to help you get started:
1. Familiarize yourself with the course materials: Ensure you understand what you'll be studying in this module, what the learning outcomes are, and how the course is structured.
2. Manage your time effectively: Set aside a specific amount of time each day or week to work on this module. Make a schedule that works for you, and stick to it as much as possible.
3. Stay organized: Keep track of your progress by taking notes, using a planner, or using an online tool to keep track of your assignments and deadlines.
4. Participate in the online discussions: Take advantage of any online forums or discussion boards that are available to you. Engage with your fellow learners, ask questions, and share your own experiences and insights.
5. Complete all assignments: Make sure you complete all the assignments and quizzes associated with this module. This will help you reinforce what you've learned and prepare you for any assessments that may be required.
6. Seek help when needed: If you're struggling with any part of the module, don't hesitate to reach out to your facilitator or the support team for help. They're there to assist you and help you succeed.

Remember, learning is a process, and everyone learns at their own pace. Don't be discouraged if you encounter challenges along the way. With persistence and effort, you can master the material and achieve your learning goals.

 Good luck!


	Learning module description
	The input forms and reports module is designed to provide learners with a comprehensive understanding of how to create and manage data input forms and generate reports effectively.

	Module objectives:

	 The module seeks to facilitate learning about:
1. Purpose, role and types of input forms and reports as used in database management
2. The importance of data validation and how it helps maintain data accuracy
3. Creating and modifying input forms and reports using a DBMS.
4. Problem solving skills by troubleshooting issues related to input forms and reports

	Module learning outcomes:


	By the end of the module  you should be able to:
5. Describe purpose, role and types of input forms and reports as used in database management
6. Explain the importance of data validation and how it helps maintain data accuracy
7. Create  and modify input forms and reports using a DBMS
8. Develop problem solving skills by troubleshooting issues related to input forms and reports

	Planned Learning Resources
	A Computer, course modules, online based materials, virtual lab, recorded lecturers, assessment tools, online videos, case studies, LMS, eBooks, books, interactive quizzes, Smart phones, virtual tools such as Zoom , google meet

	ACTIVITY 1: INTRODUCTION
VIDEO 1: Pre-recorded lecture on topic emphasizing LEARNING OUTCOME 1:
 Factual knowledge.
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	Designer: Provide a video with  the following prerecorded information



Input forms in Ms Access

In Microsoft Access, input forms are used to collect data from users and store that data in the database. Here are the steps to create an input form in Access:

· Open Microsoft Access and select the database that you want to work with.
· Click on the "Forms" tab in the left navigation pane.
· Click on the "Create Form" button in the ribbon menu.
· Select the table or query that you want to use as the data source for your form.
· Choose the fields that you want to include in your form and drag them onto the form design canvas.
· Arrange the fields on the form design canvas and customize the layout and formatting as desired.
· Add any additional form controls that you want, such as buttons or labels.
· Save your form and give it a descriptive name.
Once you have created your input form, you can use it to add new records to your database or edit existing records. You can also customize the behavior of your form using various Access features, such as macros and event procedures.

Add records using input forms
To add records to a Microsoft Access database using an input form, follow these steps:

· Open the input form that you want to use to add records.
· Click on the "New Record" button in the navigation bar at the bottom of the form. This will create a blank record in the form for you to fill in with data.
· Enter the data for the new record in the form fields. Make sure to fill in all required fields, as indicated by asterisks or other indicators on the form.
· If there are any lookup fields or drop-down lists on the form, select the appropriate values from the lists.
· Once you have entered all of the data for the new record, click on the "Save Record" button in the navigation bar. This will save the new record to the database.
· Alternatively, you can press the "Enter" key on your keyboard to save the new record, or you can click on the "Close" button in the navigation bar to discard the new record.

If there are any validation rules or error messages associated with the form, Access will prompt you to correct any errors before saving the new record. Once the new record has been saved, you can view it in the form or in the underlying table or query in the database.

Validation rules and error messages with forms in Ms Access
Validation rules and error messages are important features of input forms in Microsoft Access that help ensure data integrity and accuracy. Here are the steps to create validation rules and error messages with forms in Access:

· Open the input form that you want to add validation rules and error messages to.
· Click on the field that you want to add a validation rule or error message to.
· Click on the "Property Sheet" button in the "Tools" group of the "Design" tab on the ribbon menu.
· In the "Property Sheet" pane, select the "Validation Rule" property.
· Enter the validation rule expression in the field provided. For example, you could use the expression ">=0" to ensure that the value entered in the field is greater than or equal to zero.
· Optionally, you can also specify a custom error message for the validation rule by entering text in the "Validation Text" property.
· Repeat steps 2-6 for any additional fields that require validation rules or error messages.
· Save your form and test it by entering data that violates the validation rules.
When a user attempts to enter data that violates a validation rule, Access will display the custom error message (if one has been specified) and prevent the user from saving the record until the error has been corrected. This helps ensure that the data in your database is accurate and consistent.

Note that you can also use other Access features, such as macros and event procedures, to create more advanced validation rules and error messages. For example, you could use a macro to display a message box when a user enters an invalid value, or you could use an event procedure to automatically correct common data entry errors.

Create validation rules in Ms Access
Validation rules in Microsoft Access are used to ensure that data entered into a table or form meets certain criteria. Here are the steps to create a validation rule in Access:

· Open the database that contains the table or form you want to add the validation rule to.
· Select the table or form that you want to add the validation rule to.
· Click on the "Design View" button in the ribbon menu.
· Select the field that you want to add the validation rule to.
· In the "Field Properties" section of the table or form design view, click on the "Validation Rule" property.
· Enter the validation rule expression in the field provided. For example, if you want to ensure that the data entered in the field is a number between 1 and 100, you can enter the expression ">=1 And <=100".
· Optionally, you can enter a custom error message to display if the data entered does not meet the validation rule by setting the "Validation Text" property.
· Save the table or form.
When a user enters data that violates the validation rule, Access will display the custom error message (if one has been specified) and prevent the user from saving the record until the error has been corrected. This helps ensure that the data in your database is accurate and consistent.

Note that you can use more advanced validation rules by using more complex expressions, or by combining multiple validation rules with logical operators like "And" and "Or". You can also use Access's built-in validation rule templates, which can be accessed by clicking on the "..." button next to the "Validation Rule" property. These templates can help you create validation rules for common scenarios, such as ensuring that a field contains a valid email address or a valid date.




Example of Access Validation rule
Here's an example of a validation rule in Microsoft Access:

Let's say you have a table that stores information about employees, including their age. You want to ensure that the age entered for each employee is between 18 and 65.

To create a validation rule for this field, follow these steps:

· Open the table in Design View.
· Select the "Age" field.
· In the "Validation Rule" property, enter the following expression: >=18 And <=65
· In the "Validation Text" property, enter a custom error message such as "Please enter an age between 18 and 65."
· Save the table.
Now, whenever a user enters an age that is not between 18 and 65, they will see the custom error message and will not be able to save the record until the error is corrected. This ensures that the data in your table is accurate and consistent.

Reports in Ms Access
In Microsoft Access, a report is a database object used to display data in a formatted way for printing or viewing on screen. Reports allow you to organize and summarize data from one or more tables or queries, and can include charts, graphs, and other visual elements.

Here are the basic steps to create a report in Microsoft Access:

· Open the database that contains the table or query you want to base your report on.
· Click on the "Create" tab in the ribbon menu.
· Click on the "Report Wizard" button.
· In the "Tables/Queries" dialog box, select the table or query you want to use as the data source for your report.
· Select the fields you want to include in your report and arrange them in the order you want them to appear.
· Choose a report layout and style.
· Customize the report design as needed, using the tools in the "Design" tab on the ribbon menu.
· Save your report.
Once your report is created, you can view it by selecting it in the Navigation Pane and clicking on the "View" button. You can also print the report by clicking on the "Print" button in the ribbon menu.

Reports in Access can also be customized in a number of ways, including adding grouping and sorting options, adding calculated fields, and using expressions to customize the data displayed in the report. You can also create subreports to display related data within a main report.


View Reports in Ms Access
To view a report in Microsoft Access, follow these steps:

· Open the database that contains the report you want to view.
· In the Navigation Pane, locate the report you want to view and select it by clicking on its name.
· Click on the "View" button in the ribbon menu to display the report in the default view.
· If you want to change the view of the report, click on the "View" drop-down button in the ribbon menu and select the desired view, such as "Print Preview" or "Layout View".
· Navigate through the report by using the scroll bars or the arrow buttons at the bottom of the screen.
In addition to viewing reports in Access, you can also print reports by clicking on the "Print" button in the ribbon menu. You can also export reports to other file formats such as PDF or Excel by clicking on the "Export" button in the ribbon menu and selecting the desired file format.

Customize the data displayed in a report
In Microsoft Access, you can customize the data displayed in a report using expressions. Here are the steps to customize the data displayed in a report:

· Open the report in Design View by selecting it in the Navigation Pane and clicking on the "Design View" button in the ribbon menu.
· Select the control containing the data you want to customize.
· In the "Control Source" property of the control, enter an expression that calculates the desired value based on the data in your database. For example, you can use the following expression to calculate the total cost of an order based on the unit price and quantity fields: =[UnitPrice]*[Quantity]
· Save the report and switch to Print Preview to see the customized data.
You can use a wide range of functions and operators in expressions to customize the data displayed in your report. For example, you can use functions like Sum, Avg, and Count to perform calculations on groups of data, or use operators like +, -, *, and / to perform arithmetic operations on individual fields. You can also use conditional expressions to display data based on certain criteria, such as displaying a message if a certain value is missing or displaying different data based on the value of another field.

Types of reports in Ms Access
In Microsoft Access, there are several types of reports that you can create, depending on the purpose of the report and the type of data you want to display. Here are some of the most common types of reports:

1. Tabular Reports: These reports display data in a simple table format, with each row representing a record and each column representing a field. Tabular reports are useful for displaying large amounts of data in a concise and organized manner.

2. Grouped Reports: These reports group related data together based on a common field, such as a category or date range. Grouped reports are useful for summarizing data and displaying subtotals and totals for each group.

3. Summary Reports: These reports summarize data by calculating totals, averages, and other aggregate functions for each field or group. Summary reports are useful for analyzing data and identifying trends or patterns.

4. Parameter Reports: These reports allow the user to specify criteria for filtering the data displayed in the report. Parameter reports are useful for creating custom reports that meet specific requirements.

5. Mailing Labels: These reports are designed to print mailing labels for a list of contacts or customers. Mailing labels are useful for creating bulk mailings and for keeping track of contact information.

6. PivotTable Reports: These reports allow you to analyze and summarize large amounts of data by creating pivot tables that can be sorted, filtered, and manipulated to show different views of the data.

These are just a few examples of the types of reports you can create in Microsoft Access. Each type of report has its own unique features and advantages, and you can customize the design and layout of each report to meet your specific needs.

Purpose of reports
The purpose of reports in Microsoft Access is to provide a visual representation of the data stored in the database. Reports are designed to make it easy to understand and analyze data by summarizing, grouping, and filtering it in various ways. Reports allow you to:

1. View data in an organized and structured way: Reports present data in a logical and organized manner, making it easier to analyze and understand.

2. Summarize data: Reports can summarize data by calculating totals, averages, and other aggregate functions for each field or group, providing an overview of the data.

3. Group and categorize data: Reports can group related data together based on a common field, such as a category or date range. This allows you to analyze data at a more detailed level.

4. Filter data: Reports can be filtered to show only the data that meets specific criteria, allowing you to create custom reports that meet specific requirements.

5. Present data visually: Reports can present data using charts, graphs, and other visual aids, making it easier to identify trends and patterns.

6. Print or export data: Reports can be printed or exported to other formats such as PDF or Excel, allowing you to share data with others or use it in other applications.

Reports are an essential tool for data analysis and management, and they play a critical role in helping organizations make informed decisions based on the data stored in their databases.


	
	1. Click the link below to watch the two videos on purpose, role and types of input forms and reports as used in database management.
2.  Write your own notes to summarize what you have watched. This notes will guide you in responding to the questions that follow.

Video 1
Title: MS Access - Forms Part 1: Basic forms
Video Link: https://youtu.be/P7jABZ97p-E
Source: Mr. Long Education IT &CAT
Time taken to watch the video (minutes: seconds): 11:04

Video 2
Title: MS Access - Reports Part 1: Basic reports
Video Link: https://youtu.be/gW_8VgKCO2M
Source: Mr. Long Education IT &CAT
Time taken to watch the video (minutes: seconds): 10:59



	ACTIVITY 2: READING
READING MATERIAL 1
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	1. Access the reading material below on purpose, role and types of input forms and reports as used in database management.
2. Make your own notes as they will guide you in answering the questions that follow.

Title: Ms-Access Forms
Link: https://gcwgandhinagar.com/econtent/document/15877166711CAPSE0601_UNIT-4.pdf


Title: Introduction to Microsoft Access 2016
Link: https://www.montclair.edu/information-technology/wp-content/uploads/sites/168/2018/06/Access-Intro-2016.pdf
Page 6 to 11


Title: Ms Access Tutorial Point
Link: https://www.tutorialspoint.com/ms_access/ms_access_tutorial.pdf



Designer: avail the reading materials for the learner.

	ACTIVITY 3:  Comprehension questions:
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	1. Having watched the videos and read the book chapter on purpose, role and types of input forms and reports as used in database management, attempt ALL of the following multiple choice questions. 
2. You are expected to get at least eight questions correct in order to proceed to the next activity.
3. This Activity will be graded

Questions
1. What is a form in Microsoft Access?
A) A tool to create queries
B) A tool to create reports
C) A tool to create tables
D) A tool to enter and view data
2. Which type of form displays all records in a table or query?
A) Split Form
B) Single Form
C) Datasheet Form
D) Multiple Items Form

3. What is a report in Microsoft Access?
A) A tool to create queries
B) A tool to create forms
C) A tool to create tables
D) A tool to display data in a formatted and organized manner

4. What type of report summarizes data by calculating totals, averages, and other aggregate functions for each field or group?
A) Tabular Report
B) Grouped Report
C) Summary Report
D) Parameter Report
5. Which type of report allows you to analyze and summarize large amounts of data by creating pivot tables?
A) Tabular Report
B) Grouped Report
C) Summary Report
D) PivotTable Report
6. Which of the following is NOT a type of form in Microsoft Access?
a) Tabular Form
b) Split Form
c) PivotTable Form
d) Continuous Form

7. In Microsoft Access, a report is used to:
a) Enter data into a database
b) Edit data in a database
c) View data in a database
d) Print or export data from a database

8. Which of the following is a way to add a control to a form in Microsoft Access?
a) Using the Insert tab in the ribbon
b) Dragging a control from the Navigation pane onto the form
c) Right-clicking on the form and selecting "Add Control"
d) All of the above
9. Which of the following is a type of report in Microsoft Access?
a) Formatted Report
b) Grouped Report
c) Conditional Report
d) Sorted Report

10. Which of the following is a way to add a calculated field to a report in Microsoft Access?
a) Using the Expression Builder
b) Dragging a field from the Navigation pane onto the report
c) Right-clicking on the report and selecting "Add Calculated Field"
d) All of the above
Designer: What is highlighted in red is the correct answer. Each question carries one point. If a learner does not get atleast eight correct answers then the learner should be referred back to watch the videos and re read the book chapter


	LEARNING OUTCOME 2: Conceptual knowledge


ACTIVITY 4: Video to be used.

	1. Click the link below to watch the three videos on the importance of data validation and how it helps maintain data accuracy.
2. Take notes to guide you in answering questions that will follow.


Video 1
Title: Validation rules in MS Access
Video Link: https://youtu.be/o8TGku9fxI8
Source: Bind Azeez
Time taken to watch the video (minutes: seconds): 9:31

Video 2
Title: MS Access - Tables Part 2: Validation Rules
Video Link: https://youtu.be/fxQQUURyn7Y
Source: Mr. Long Education IT& CAT
Time taken to watch the video (minutes: seconds): 7:21

Video 3
Title: MS Access 2016 - Field and Record Validation
Video Link: https://youtu.be/vCCrJXcpHqg
Source: TutorialPoint
Time taken to watch the video (minutes: seconds):  8:27



	CASE 1:
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	1. Read the case scenario below on the importance of data validation and how it helps maintain data accuracy.
2. Write your notes to summarize what you have understood from the case scenario. These notes will guide you in responding to the questions after the case.
3. Respond to the questions after the case
4. Each question carries one point
5. Upload your answers to the LMS.
6. Each answer you  give should not exceed twenty (20) words

Case Scenario:
ABC Corporation is a leading multinational company with a vast database of customer information. Recently, the company has noticed that the accuracy of their data has been declining. They realized that the problem was due to the data being entered incorrectly, such as incorrect customer names, email addresses, phone numbers, and other details. This led to a considerable amount of time and resources being wasted on correcting these errors.

To prevent this problem from happening again, the company decided to implement a data validation process. The validation process ensures that all the data entered into their database is accurate and complete. Before the data is stored, the system validates the input data against predefined criteria. If any errors are found, the system automatically flags them and prompts the user to make the necessary corrections.

The data validation process has helped the company to maintain the accuracy and completeness of their database. It has also helped to save time and resources that were previously spent on correcting errors. The company can now rely on their data to make informed business decisions with confidence. 
1. After reading the case scenario on the importance of data validation and how it helps maintain data accuracy answer the questions below.
2. The write-up of your answers should not be more than 200 Words
3. Upload the write-up of your answers on to your E-Portfolio on  the LMS 


Questions

1. Explain data validation, and how does it contribute to data accuracy?
2. Explain the consequences of inaccurate data, and how can data validation help prevent them?




	[bookmark: _Hlk131239802]ACTIVITY 5: READING MATERIAL 
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	1. Click the link below to access the reading material on the importance of data validation and how it helps maintain data accuracy 
2. Summarize your understanding of the read material and post it on the blog. 
3. The write-up should not be more than 500 characters.
4. Upload the write-up on the LMS 

Title: How to use data validation rules in Ms Access 2016
Link: https://www.accessrepairnrecovery.com/blog/ms-access-validation-rule


Designer: Download and make the reading material accessible to learners. 


	ACTIVITY 6: ONLINE DISCUSSION
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	1. Join and participate on this discussion forum on the importance of data validation and how it helps maintain data accuracy Form groups of five learners
2. Ensure you post your discussion on the forum and critique at least two posts posted by other learners.
3. Your answer should be brief and to the point, not more than 50 words per answer
4. This activity will be graded.


Discussion Questions

1. Discuss how can companies implement data validation processes effectively?
2. Discuss the challenges that companies may face while implementing data validation processes?
3. Discuss how companies ensure that their data validation processes remain up-to-date and effective?




Designer: Create a discussion forum and Provide a mechanism to award points to those who participate in this discussion. Award  five points for participation


	 LEARNING OUTCOME 3: PRACTICAL SKILLS
VIDEO 3: 
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	1. Click the link below to watch the two videos on how to create  and modify input forms and reports using a DBMS
2. Based on what you have watched, write your own short notes
3. These notes will guide you in performing the task that follow.

Video 1
Title: Access: Creating Forms
Video Link: https://youtu.be/dEaQIrw3CZY
Source: GFCLearnFree
Time taken to watch the video (minutes: seconds):  4:12

Video 2
Title: Access: Creating Reports
Video Link: https://youtu.be/1XUeGq80R5Q
Source: GFCLearnFree
Time taken to watch the video (minutes: seconds):  2:56


	
ACTIVITY 7: Learner practice sessions
	1. After watching the videos on how to create and modify input forms and reports using a DBMS, practice the skills learnt by performing the tasks below.
2. You will be required to self-recorded yourself as you perform the tasks
3. Ensure you explain the activity as you conduct it
4. The self-recorded video should not exceed 60 seconds 
5. Upload the self-recorded video showing you, performing the tasks to your E-Portfolio
6. This activity will be graded.

Tasks


Part 1: Creating an Input Form
· Open Microsoft Access and create a new blank database.
· Create a table with the following fields: ID, First Name, Last Name, Email, and Phone Number.
· Save the table with a name of your choice.
· Click on the "Create" tab and select "Form Design" to create a new input form.
· Add the fields from the table to the form by selecting them from the "Add Existing Fields" option in the "Design" tab.
· Customize the form's design by adding a title, adjusting the font, and changing the colors to your preference.
· Save the form with a name of your choice.
Part 2: Modifying an Input Form

· Open the input form you created in Part 1.
· Click on the "Design" tab and modify the form's layout by resizing the fields, adding labels, and moving the fields around to improve the form's usability.
· Add a new field to the form by selecting "Add Existing Fields" and choosing the field you want to add.
· Modify the form's properties by selecting "Properties" and adjusting options like the form's default view and the tab order of the fields.
· Save the modified form with a new name to avoid overwriting the original form.
Part 3: Creating a Report

· Open the database you created in Part 1 and click on the "Create" tab.
· Select "Report Design" to create a new report.
· Add the fields from the table to the report by selecting them from the "Add Existing Fields" option in the "Design" tab.
· Customize the report's design by adding a title, adjusting the font, and changing the colors to your preference.
· Save the report with a name of your choice.
Part 4: Modifying a Report

· Open the report you created in Part 3.
· Click on the "Design" tab and modify the report's layout by resizing the fields, adding labels, and moving the fields around to improve the report's readability.
· Add a new field to the report by selecting "Add Existing Fields" and choosing the field you want to add.
· Modify the report's properties by selecting "Properties" and adjusting options like the report's default view and the sorting order of the data.
· Save the modified report with a new name to avoid overwriting the original report.


	ASSESSMENT OF PRACTICAL SKILL:

	Marking scheme for the practical
· Award three points to each of the four parts of the task. 
· Award two points for following instructions


	LEARNING OUTCOME 4: KEY/TRANSFERABLE SKILLS
	1. Click the link below to access the reading material on problem solving skills by troubleshooting issues related to input forms and reports 

Title: Microsoft Access, short Questions and answers with illustrations
Link: https://mcqsets.com/dwnld/MS-Access-Short-Questions-Answers.pdf


Designer: Make the reading materials accessible to the learner

	ACTIVITY 8
	1. This activity aims to demonstrate transferable skills on problem solving skills by troubleshooting issues related to input forms and reports. 
2. You are required to carry out the tasks given below.
3. Self-record the a presentation on troubleshooting issues related to forms and reports
4. The recording should not exceed 120 seconds
5. You will require a computer installed with a database software
6. The Activity will be graded

Task
Prepare a presentation on troubleshooting issues related to forms and reports in Ms Access

	QUIZZ: 
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	Having watched videos read materials, responded to a case study and performed practical exercise. Undertake the following quiz to test your knowledge and skills acquisition on this module.

1. What is a form in Microsoft Access?
a) A database object used to organize and view tables
b) A way to group related data from multiple tables
c) A report that summarizes data in a table
d) A tool used to create queries in Access
2. Which of the following statements is true about a report in Microsoft Access?
a) A report is used to enter data into a table.
b) A report is used to create a visual representation of a table or query's data.
c) A report is used to create relationships between tables.
d) A report is used to create a database backup.
3. How can you modify the layout of a form in Microsoft Access?
a) By selecting "Report Design" in the "Create" tab.
b) By selecting "Design View" in the "Home" tab.
c) By selecting "Layout View" in the "View" tab.
d) By selecting "PivotTable View" in the "View" tab.
4. Which of the following statements is true about a subform in Microsoft Access?
a) A subform is used to create a visual representation of a table or query's data.
b) A subform is used to group related data from multiple tables.
c) A subform is a form embedded within another form.
d) A subform is used to create a report.
5. What is the purpose of a parameter query in Microsoft Access?
a) To create a form for data entry.
b) To calculate the average of a set of values.
c) To prompt the user for input before running the query.
d) To create a report that summarizes data in a table.


Designer: What is highlighted in red is the correct answer. Each question carries one point. If a learner does not get atleast nine correct answers then the learner should be referred back to watch the videos and re read the materials provided


	TAKE HOME MESSAGE
	On the blog, post your take home message about this module
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